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TurningPoint AnyWhere 3.0 (PC) Release Notes

Software Name: TurningPoint AnyWhere 3.0 (PC)
Release Date: 06/30/2011

Version: 3.0.2.1171

Support: support@turningtechnologies.com
Overview:

Languages: English

Minimum System Requirements:

Microsoft Windows 32 or 64 bit XP, Vista or 7

Intel or AMD 600 MHz class processor (1 GHz or higher recommended)

256 MB RAM

60 MB hard disk space (an additional 32 MB is required if you do not have Microsoft
.NET Framework 2.0 installed)

1024 x 768 resolution on a 32-bit color or higher

Standard USB 1.1/2.0 port (for USB-based hardware devices)

Ethernet or 802.11 compatible wireless network card*

Requires the RF or IR Receiver or an active ResponseWare account

*Required if ResponseWare or PresenterWare is used.

* Customers using a ResponseCard Receiver with a part number on the back label of
“RRRF-01" or “RRLR-01" and have never had any Turning Technologies product
installed on the computer, must run the ftdi.exe file located in C:\Program
Files\Turning Technologies\TurningPoint AnyWhere 2008 or the specified
download location in order to use the receiver with TurningPoint AnyWhere 2.1 or
greater. For non-installed versions of the application the ftdi.exe file can be found in
the TurningPoint AnyWhere 2008 folder under Misc.

3.0.2.1171
Fixes:

o Resolved the connection issue with the Blackboard integration.

o Resolved the connection issue with the Sakai Integration with CAS authentication.

¢ Resolved the issue with the export wizard adding the percentage correct value to all
exports.

Known Issues:

¢ If using Participant lists from an LMS that contains duplicate device IDs, the program
freezes when saving and loading the Participant List. This issue is occurring because
the Save prompt is appearing behind the Participant List Editor window.

Workaround: Press either the Escape or Enter key to close the Save prompt. Once
this is done, saving or closing works normally.
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3.0.1.1109

Enhancements:
e Added PresenterCard support.
Ability to import QuestionPoint essay questions.
Ability to automatically check for and install updates.
Ability to denote a question as demographic.
Ability to compare the results from two questions.
Ability to setup Groups or Teams in Participant Lists.
Ability to display Team & Participant Leaderboards and Fastest Responders from the
Chart screen.
Ability to connect to RemotePoll via an IP Address.
Ability to view screenshots and charts in session viewer.
Ability to designate teams and demographics in questions.
New report type of Demographic Comparison.
New report type of Team Scores.
Users will receive notification when changing participant list to anonymous.
Ability to display response times in Participant Reports.
Common Core Standards Support.
Ability to print question list without needing to load list first.
New Question Type of Essay.
Ability to include headers in export wizard.
Ability to set response selection between Alpha & Numeric.
Ability to Print Participant list from Participant list editor.
Support for use of ResponseWare in a Proxy Server environment.
Added Launchpad to provide quick access to commonly used features.
Added one click buttons for commonly used features to the showbar.
Ability to directly export to ResultsManager if ResultsManager and TurningPoint
AnyWhere are installed to the same directory.
Ability to duplicate questions in question lists.
Ability to customize size and contents of Response grid.

2.5.0.1007
Enhancements:
¢ Added launchpad interface at start of program.
¢ Added Polling Assistant to aid in set-up of session.
¢ Added ability to save a session directly to ResultsManager 1.1 or higher.
e Added support for invalid SSL certificates.

2.4.0.280
Fixes:

e Saving a report with the "Show all Participant Fields" box checked as a CSV file was
not saving properly.
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Enhancements:

Support for ResponseCard NXT.
Support for PresenterWare. (Coming Soon!)
IP Address settings are now auto-populated for PresenterWare.

2.3.0.210

Known Issues:

If the Invalid Response Notification setting is set to True, and you are polling a
multiple response question with a ResponseCard XR, the responses must be sent
individually.

Enhancements:

Multiple Response Questions

Assign multiple correct answers for quick poll questions
Option to set a default number of answer options for quick poll
Question Lists can now be edited and loaded

Start Polling

Stop Polling

Countdown Timer

Anonymous Question

Session

Question List Load Question List

Participants Close Question List

e Mew Question List

r v v |w |

Toal
oo Edit Current Question List

Load and Edit Question List

TurningTalk

Help

Print Current Question List

About

Exit
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e Print currently loaded Question Lists

0 = da are a leap
PO 1 D i o i
Start Polling »
Stop Polling

Countdown Timer

Anonymous Question

Session 3
Question List 4 Load Question List
Participants 4 Close Question List
View 3

he Mew Question List
Toal 4

aals Edit Current Question List
TurningTalk Load and Edit Question List
Hel

=R Print Current Question List
About
Exit

o Participant Lists can be saved and loaded

V:| Participant Information - New List 79.6.2010 13-15-40

Open  Ctrl+0

Save crl4s st Name First Name Student ID

Save and Load

Save As...
Find Ctrl+F

Exit F10

e Question Lists can be closed directly from the TurningPoint AnyWhere Showbar

F:| TurningPoint AnyWhere
Responses Feedback
> IIII 0 | 0

4« How many days are in a leap yo¥ | X

Polling Closed {lof ) ™ §
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User Interface Changes:

e The Start Polling sub-menu has been re-ordered

Version 2.2 Version 2.3
F:| TurningPoint AnyWhere

R
|

Polling Closed

Start Poliing Custom Start Polling » Custom
Stop Polling Stop Poling
SR - Fill in the Blank =R - 2 Answers
Courntdown Timer Mumeric Response Countdown Timer 3 Answers
Anonymous Question Anonymous Question T
Anany Q 10 Answers Anany Q 4 Answers
Session 3 Q Answers Session 5 Answers
Question » 3 Answers Question List 6 Answers
Participants 3 7 Answers Participants 7 Answers
View » & Answers View 8 Answers
Tools 3 5 Answers Tools 3 Answers

- 10 Answers
TurningTalk 4 Answers TurningTalk
Help 3 Answers Heln Fill in the Blank
About 2 Answers About Mumeric Response
Exit Exit

e Countdown Timer icons for increasing and decreasing time have been replaced with
+ and - signs

Version 2.2 Version 2.3
Countdown Timer

e The Response/Nonresponse Grids now appear with a solid white background

¢ In the Standards window, the "Built-in Standards" tab is now labeled "K-12
Standards”

¢ In the Report Window, the "Load Session" button is now labeled "Import Session"
In the main menu, the "Question" option is now labeled "Question List"

2.2.0.85
Fixes:
¢ If a QuestionPoint file contained questions with tables the Turning Parser would not
generate the questions

e The "Save Information Checkbox" did not save the password on the ResponseWare
Login Window
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e Continuing a prior session and assigning a participant list was not updating the

participant information

e If a Question List was loaded and the B3 button on the showbar was selected to hid
the response/feedback count and the application was then closed, upon restart of the
application the Question List would not be loaded but the area where the Question
List would have been displayed was still appearing

e Importing a QTI.zip file in the question editor was unsuccessful

Enhancements:

e Countdown Timer

With Polling Open: kd > Countdown Timer

Countdown Timer

"_‘1 Settings

Application
Presentation
General

Response Devices

Polling Test

Application Settings
File Location

Language

Shortcut Keys

Start/Stop Poling

|achnn\ngiss‘-,Turninan\nt AnyWhere 2008 ” Browse. ..

[Engish-Us

Ctrl+Alt+1

Change

Show Hide Countdown Timer
Play/Pause Countdown Timer
Show fHide Response Grid

Show [Hide Monresponse Grid

Miscellaneous
Countdown Timer Duration
Carrect Point Value
Incorrect Point Value
Show Balloon Tip

Background Color

Ctrl+Al+T
Ctrl+Alt+P
F7

3]

| Change |
Change
Change

Change

| True

18, 18, 18

Defaults Keyboard shortcut to show or hide the countdown timer.
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e Response/Nonresponse Grid

kd > View > Response Grid OR Nonresponse Grid

Christopher Columbu Rosa Parks
4 141F 1012

Or Specify a shortcut keystroke in the Application Settings
e Data Export Wizard

k4 > Tools > Export Wizard

Export Wizard

(%) Create or Edit Export Schemes

) Quick export using a previously crested export scheme

Select a previously created scheme for your data export or optionally create a new scheme

{Mew Scheme) [v LHUV\'SE“ »

wp |“Blackboard
“Lesiredlearn
“Sakai
“WebCT

* hdheres to a standard and may not be edited

Step 1 of 4 e
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QuestionPoint, XML and QTI parser support

k4 > Question > New Question List
Question Editor > Import Question

V:| Question Ecitor

Add Question

Delete Question

= i

Standards

Import Question

uestion List
1.  Enter question text... | < T
Sessian
Question Properties
| QuestionPaint
QTI Document - | [ anonymous
XML Document - T [w T i =——r1
r answer text... |No Value | E Correct Value | 1

Incorrect Value

2 !Enter answer text.

| [ T [ ]

Presentation Properties ——

[] pisplay Correct Answer Indicator
[] pisplay Countdawn Timer

Seconds &

Add Answer Choice

Moodle and Performance Matters integration support

R4 > Tools > Integrations

r_‘1 TurningPoint AnyWhere - Integrations

Learning Management System
Leaming Management System

Management System

Blackboard

Moodle

Performance Matters

Sakeai

Tuming Technologies Web Registration Ltility
WebCT 6/\ista Editions

Server URL

Created on 3/22/2011 9:03:00 AM



Fmin .
echnologies

1-866-746-3015
www.TurningTechnologies.com

2.1.0.9296

Fixes:

Updated user guide contains instructions for customers using a ResponseCard
Receiver with a part number on the back label of "/RRRF-01" or "RRLR-01."

2.1.0.9287

Fixes:

Attempting to connect to a ResponseWare session after the session had been
created and polling was already opened would not allow you to connect

Device IDs were not imported for a WebCT Participant List

Importing a Participant List from an LMS and changing a Device ID would not allow
you to export the grades back to the LMS

Checking the option to poll a question anonymously would cause an error when
polling was closed

If Enforce Participant List was set to True, ResponseWare users were unable to join
the session

Enhancements:

TurningPoint AnyWhere no longer requires installation
Added direct link to the TurningTalk user community
Added Sakai integration into LMS

Anonymous polling— Start polling anonymously any time under the Main
menu>Anonymous Question

Real-time registration tool — Allows students to register their devices to TurningPoint
AnyWhere in real-time during class

Save an exportable file in the format of CSV for easy upload to an LMS.

Participant list display — shows the current participant list loaded similar to the real-
time registration tool

Numeric Response Only Question — Similar to FIB question but will only accept
numeric responses and will be graded upon the range set up (e.g. anything between
1 and 10 is correct)

Default Correct Point Value from 100 to 1

2.0.0.9212

Fixes:

Continuing a TurningPoint 2006 session and then opening the Session Viewer
caused an error

Editing question text in a new Question List would sometimes cause a loop of errors

Trying to remove a participant from the Participants section of the Session Viewer
after attempting to clear or correct a duplicate Device ID caused an error
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Enhancements:

* Added language support for: Dutch, French, German, Spanish, Portuguese,
Japanese, Korean, Russian

2.0.0.9153
Fixes:

¢ When exporting a session to Blackboard the Blackboard ID field was blank

e Using a Participant List from TurningPoint would award attendance points for non-
responders when exported to Blackboard

e Blackboard Wizard did not support a Single Sign On (SSO) connection

Enhancements:

* Dynamic charting
* Reports are now generated in HTML - no need for Microsoft Office
* Added a screenshot report that shows results, questions and a screenshot

* Added the ability to create question lists and assign correct answers with correct
answer indicators

* The application menu can now be accessed directly from the showbar
* Added more user preferences
* Now supports Windows 64-bit OS

1.0.0.7323

Product Release
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